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System Requirements 
• Windows 95/98/Me/NT 4.0/2000/XP 
• 486 or higher CPU 
• 8MB RAM 
• Network connection-local or remote 

 
Network Requirements 
Network/Unplugged supports most common computer network types, including Microsoft 
Networks, Netware Networks, LANtastic, and NFS. 

 
How to Reach Us 
Check out our Web site, www.mobiliti.com for the following: 
 
To register online 

• For installation and technical assistance 
• To obtain the product on a different medium 
• For information and technical documentation. 

 
 

 
2025 Lincoln Highway, Suite 207A 
Edison, NJ  08817 
Toll Free: 1-877-UNPLUGGED 
Tel:  (732) 248-8300 
Fax: (732) 248-8060 
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Glossary 
 
Attached Mode When a computer is a participating member of a network, or is 
accessing network resources via another method such as a dial-up connection, it is in 
Attached Mode. 
 
Detached Mode When a computer is not a member of a network, and is not using any 
network resources, it is in Detached Mode.  
 
Dial-Up Networking The method by which a remote computer can dial into a network 
using a modem and phone connection.  
 
File Selector A File Selector points to a file or a folder.  A Project is made up of one or 
more File Selectors. 
 
Icon A small graphic that represents an element such as a Program, a disk drive or a 
document on the desktop.  
 
Local The term used to refer to versions of network files that are stored on the Local 
disk, and to which the accesses to network files are directed in Detached Mode.  These 
files are only accessible through the network and only in Detached Mode.   
 
Network The term used to refer to versions of network files that are stored on the 
network servers and computers, and to which the accesses to network files are directed in 
Attached Mode. 
 
Network Image The network that the Detached computer �sees� when the network is 
accessed. 
 
Observer With the Observer resource enabled, the program tracks all the network files 
accessed for a specified number of days (maximum: 100).  This allows the system to 
suggest files for inclusion in a Project in the New Project Wizard. (Enable/Disable the 
Observer option in the Preferences option in the File menu.) 
 
Project A Network/Unplugged Project is a logical grouping of files or sets of files that 
you will require for a specific task while your laptop is disconnected from the network. A 
Project has a name, and contains a number of File Selectors. 
 
RAS A RAS server allows remote computers to dial in over a phone connection and 
become members of a LOCAL network. 
 
Selector See File Selector 
 
Synchronization The process that makes two or more files at different locations 
identical.  In this case it refers to the files on the Network and the files in the Network 
Image. 
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1       Introducing Network/Unplugged 
 
Network/Unplugged provides a comprehensive and automatic synchronization and backup 
solution for today�s remote and mobile workers. Users can operate in a Virtual Network 
environment when detached from the network, making Network/Unplugged�s 
synchronization solution extremely easy to use.  Network/Unplugged�s proprietary and 
patent-pending technologies enable fast synchronization and backup ensuring that only the 
portions of files that have changed are transmitted during synchronization and backup. 
Network/Unplugged provides the enterprise a cost effective software solution that is 
lightweight and scalable with deployment and administration support. 

1.1 Features and Benefits of Network/Unplugged 
 
Comprehensive Synchronization and Backup Solution 
 
• Virtual Network  

Network/Unplugged replicates the structure of the network on to the user's laptop 
creating a virtual network environment. The same mapped drives, network names, 
hierarchies, links, and shortcuts are available to the user in the disconnected state. This 
dramatically increases user productivity, as their computing environment is the same at 
all times. 
 

• Backup and Recovery 
Users can duplicate and protect the data files on their local machine by backing up their 
data files to the network. The backup synchronization process can be scheduled to run 
automatically, without user interaction.  The data file backup process can be configured 
to take full advantage of iDESP (Intelligent Delta Selection Process). Data File Recovery 
can be easily accomplished on the user�s repaired, replaced or new PC. 
 

• Backup of Outlook (.pst) files 
Large data files, such as Microsoft Outlook (.pst) files, can be incrementally backed up in 
seconds using the proprietary differencing technology (Application Independent Write 
Monitoring) in Network/Unplugged.  The benefit to the enterprise is that key data files 
are always backed up and protected, quickly and efficiently. 
 

• Any2Any Synchronization 
Synchronization and backup functions have been enhanced in Version 3.0 with the 
addition of �Any2Any� synchronization capability, which enables any folder to be 
synchronized to any other folder. 
 

• iDESP Technology for fast Synchronization and Backup 
Fast, cost effective file synchronization and backup is accomplished through iDESP 
(Intelligent Delta Selection Process) which selects the most efficient of three (3) Delta 
Synchronization Technologies utilized in Network/Unplugged: Byte Level Differencing, 
Block Level Differencing and Write Monitor Differencing.  With iDESP, only the 
changes made to a file, not the entire file, are transferred across the network in a 
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compressed format.  This increases the speed of synchronization and file backup over 
slow network connections such as dialup telephone lines, while dramatically reducing 
network bandwidth consumption. iDESP reduces synchronization time by as much as 
95-99%. The benefit to the enterprise is reduced remote access connection costs, 
reduced network traffic, and increased user productivity. 
 

• Automatic Synchronization on System Startup/ Shutdown or on Schedule 
Synchronization can be configured to be completely automatic.  Synchronization can be 
scheduled to take place on system Startup/Shutdown or at specific time(s) of the day, or 
on selected days. The benefit to the enterprise is that users do not have to remember 
when to synchronize, thereby reducing the chance of users forgetting to synchronize or 
not backing up their data. 
 

Enhanced Solution for Enterprise Rollout 
• Simple and Scalable Architecture 

The Client Software can be installed on all Windows 95/98/Me/NT/2000/XP 
workstations. The Synchronization Server Software required to leverage the full power 
of iDESP (Intelligent Delta Selection Process) is easily installed on any Microsoft NT 
Server. Installation of both the client and server software is accomplished in under 5 
minutes. 
 

• Cross Platform Capability  
Works with all Windows clients - 95, 98, Me, NT 4.0, 2000, XP and Microsoft Windows 
NT/2000, Novell Netware, Solaris, Linux, Lantastic and other Network File Servers.  
Supports IPX/SPX, TCP/IP and NETBEUI Protocols. 
 

• Trans-Communication Method  
Works on LAN, WAN, RAS, VPN, dial-up and wireless connections. 
 

• Deployment Kit  
Network/Unplugged is easy to install, and requires minimal user training. GUI interface 
with wizards and context sensitive help screens make the product simple to use for any 
user. Network/Unplugged has an integrated deployment kit that system administrators 
can use to easily configure and customize the installation of Network/Unplugged for 
enterprise rollouts.  The Deployment Kit supports silent installs and configurations 
requiring little or no user interaction. 
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Advanced Synchronization Features 
 
• Synchronization with Netware File Servers over Dial-Up 

Typically, the Client PC communicates to the Netware File Server over the standard 
Novell IPX/SPX communication protocols. These protocols are usually not enabled 
over a dial-up connection.  With the introduction of Network/Unplugged Proxy 
Synchronization Server, synchronization with the Novell Netware Server over a dialup 
connection using TCP/IP is transparently accomplished. 
 

• Synchronization over Dial-Up or Wireless without Switching States 
With Network/Unplugged, the user does not have to switch from the Virtual Network 
(not connected) state to the Real Network (connected) state for synchronization. The 
user can continue to work in the Virtual Network while connected to the network, the 
synchronization to the network transparently takes place in the background. 
 

• Synchronization over the Internet 
When connected to the Internet, the universal communication protocol is TCP/IP. 
Using Network/Unplugged Proxy Synchronization Server, synchronization with files in 
the corporate LAN/WAN is transparently accomplished. 
 

• Multi-user Functionality 
When multiple users are using Network/Unplugged on the same PC the multi-user 
functionality enables each user to only have access to his/her own Projects and File 
Selectors.  The benefit to the user(s) is that the Projects and associated File Selectors are 
specific to the individual user. 

 
This Guide 
This guide includes the information most users will require to take full advantage of 
Network/Unplugged.  For more detailed information please refer to the extensive online 
help and our Web site. 
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2 Getting Started 
 
Minimum system requirements for installation 
 

1. A 486 IBM-Compatible computer/laptop or higher with at least 8 MB of RAM 
and configured with an appropriate network client.  For Example: A Microsoft 
Network Client. 

2. At least 10 MB of free disk space for installation. (Additional free disk space 
requirement depends on the size of files required in the offline state). 

3. Microsoft Windows 95/98/Me/NT 4.0/2000/XP 
4. If dialing in to connect to your network, modem and ability to dial in using 

Remote Access or VPN Services. 

2.1 Installing Network/Unplugged 
 
To install Network/Unplugged from a CD, exit all applications and follow these steps: 
 

a) Place CD in CD-ROM drive 
b) Choose Run� from the Start menu 
c) In the open box, type E:\CLIENT\SETUP.EXE (where E is the drive letter 

assigned to your CD-ROM drive) 
d) Click OK  
e) Follow the instructions on the screen and reboot the computer before using 

Network/Unplugged 
 
On completion of the installation procedure, Network/Unplugged will have installed the 
following components: 
 

• Network/Unplugged Application. 
• Network/Unplugged Agent. 
• Network/Unplugged Help. 
• Release Notes. 
• Uninstall Network/Unplugged. 

 
The installation procedure will also create a GUI (Graphic User Interface) Icon on the 
Windows desktop and the Agent Icon on the taskbar. 

2.2 Registering Network/Unplugged 
 
If you have not registered during the setup process, you can register online in the customer 
service area of our Web site or mail in the registration card.  Registering will keep you up-to-
date on product upgrades and new associated products. 
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2.3 Running Network/Unplugged  
 
The Network/Unplugged program will be installed in the default location, C:\Program 
Files\Mobiliti\Unplugged. 
 
You can  start the program by selecting any of the following methods: 

• Double-Click on the Network/Unplugged icon on your Window�s 
desktop.  

 
• Click on the Network/Unplugged program that is installed in the 

Programs option of the Start menu. 
 

• Click the right button of your mouse on the Network/Unplugged Agent 
installed on the Windows taskbar and select Run Network/Unplugged to start 
the program. 

2.4 Uninstalling Network/Unplugged 
 
Before you start uninstalling, it is essential to synchronize with the network.  The Uninstall 
option will delete all the copies of the network files that are stored on the LOCAL machine. 
 
Option 1:  
You may uninstall Network/Unplugged by using any one of the following options: 

a) Click on the Start button on the Windows taskbar.  
b) Select the Programs option.  
c) Choose Uninstall Network/Unplugged.  

 
Option 2: 
Using the Add/Remove Programs options in Windows control panel: 

a) Click on the Start button on the Windows taskbar. 
b) Choose the control panel in the Settings option. 
c) Select Add/Remove Programs option in the control panel on your Windows 

desktop. 
d) Select Network/Unplugged program. 
e) Click on the Add/Remove option. 

 

2.5 Getting Help 
 
Context Sensitive Help is available in every dialog box. 
 
Note:  You may also access the online help by pressing the F1 key or 
clicking on the Help icon in the Network/Unplugged program toolbar for 
detailed instructions  
. 

 

 
!
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3 Quick Start Guide 
 

3.1 Application environment 
 
Project Manager 
When Network/Unplugged Application is started the main window that appears is the 
Project Manager. The Project Manager window has two panes that are similar in view to the 
windows explorer.  The left pane is the Project Pane and shows the Projects that have been 
setup.  When you select or highlight a Project in the left pane, the right pane, whose top part 
shows the File Selectors for that Project and the bottom part shows the list of destination 
locations for the project if any. 
 
Activity Log 
This window is below the Project and File Selectors panes.  Each and every time 
synchronization takes place the results of the synchronization process is displayed in the 
Activity Log Window. The output that is displayed in the Activity Log Window is 
automatically erased when Network/Unplugged Application is closed. If required the output 
in the Activity Log Window can be saved to a separate file.   
 
Menu Bar 
The Menu bar is located just below the Project Manager title bar and displays a list of 
commands that enable the user to perform various tasks in Network/Unplugged. 
 
Toolbar 
Below the menu bar is the toolbar. The icons on the toolbar provide the users with the 
ability to quickly access and execute some of the common commands available on the menu 
bar. When the mouse pointer is moved over the icons on the toolbar a brief description for 
each of the images appears to the left hand side of the status bar, located at the bottom of 
the Project Manager window. 
 
Status Bar 
In the disconnected state the number of computer resources that you are disconnected from 
will be displayed next to the word �Unplugged Computers� in the status bar. 
The right side of the status bar also displays the current day, date and time.  
 
Agent 
The Agent icon is automatically displayed on the Windows Taskbar when 
Network/Unplugged is installed.  The Agent shows the status of the network resources that 
you have synchronized with.  
 

.   
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3.2 All you need to know to use Network/Unplugged 
 
Network/Unplugged is very simple to use. First you identify the files and folders that you 
will need when disconnected from the network (by Defining Network/Unplugged 
Projects), and then you transfer the files to a network image on the laptop by synchronizing.  
(This will ensure that you are working with the latest version of the files at all times).  You 
continue to work in the detached state without disruption and then synchronize the files 
back when you connect to the network: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
There are four simple steps for using Network/Unplugged: 
Step 1. Setup projects 
Step 2. Synchronize before you disconnect 
Step 3. Work in the detached mode 
Step 4. Synchronize after you reconnect 

 

Project 

File Selector Associated with the Project 

Log showing files 
affected by 

synchronization 
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Step 1. Setup the Projects 
 
Network/Unplugged Projects describe the logical grouping of files or sets of files that you 
will require for a specific task when your LOCAL machine (example: laptop) is disconnected 
from the network.  Without a Project defined, you cannot take your network files and 
folders offline.  You may define as many Projects as you wish and edit the list of files within 
each Project at anytime. Once a Project is defined it remains available to be used until 
deleted.  
 
Before setting up Projects determine the purpose for setting up a Project based on the 
following questions: 
• Do you want to take files off your network on to your laptop to work in the offline 

mode? 
• Do you want to backup your local data to the network? Or  
• Do you want to synchronize data from one location to another on the network? 

 
Once you have identified the purpose for which you want to set up the Project, determine 
the type of Project you want to set up and select the appropriate Project Wizard to create the 
Project and select the File Selectors.  
 
There are basically three types of Projects: 
 
Virtual Network Projects 
Determine which files you will need while detached from the network.  Click on the 
Virtual Network Project Wizard icon in the program toolbar, follow the instructions, 
create a Project and include the files that you have identified as the File Selectors for 
the Project. 
 
Backup Projects 
Determine the files and folders on your LOCAL computer that you need to backup.  
Click on the Backup Project Wizard icon on the program toolbar.  The wizard walks 
you through the process of creating the Backup Project.  The steps include selecting 
the destination or location (which could be the network, another location on the local 
drive or even an external backup storage device) where you want the files to be backed 
up and selecting the file selectors from the LOCAL machine for backup. 
 
Any2Any Projects 
The Any2Any Project enables the user to select File Selectors from any source 
(NETWORK or LOCAL) and synchronize to any destination Folder (to a specific 
location on the LOCAL, to a different location on the Server, or to another Server on 
the NETWORK). 
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Step 2. Synchronize before you disconnect 
 
Synchronize before you disconnect from the network to ensure that you are working 
with the latest file versions when disconnected.  Network/Unplugged automatically 
prompts you for synchronization before you disconnect or you can click on the 
Synchronize icon on the program toolbar before disconnecting. 
 
Step 3. Work in the disconnected mode 
 
Work on your computer when disconnected from the network as if you are still connected. 
You do not have to choose or setup any configurations. Access your network files through 
the Network Neighborhood, the network mapped drives, shortcuts, and recently used files 
list. 
 
Step 4. Synchronize after you reconnect 
 
Synchronize after you reconnect to the network to ensure that any work you have done 
is transferred back to the REAL network.   When you connect back to the network 
Network/Unplugged automatically prompts you for synchronization and you can 
proceed with synchronization. If you prefer to synchronize later you can do so by clicking 
on the Synchronize icon on the program toolbar. (Unsynchronized files require careful 
management). 
 
The Agent is your indicator  
 
Observe the Network/Unplugged Agent icon on the right side of your Windows taskbar.  
The color of the Agent indicates the status of your network connection. For more 
information on the Agent, please refer to the section �Operating your computer in 
Detached Mode. � 
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4 Operating Your Computer 
 

4.1 Operating your computer in Attached Mode 
 
While attached to the network, all file activity takes place on the actual network. It is 
therefore imperative to synchronize as soon as you attach to ensure that network files are 
up-to-date. The files in the Network Image on the LOCAL machine are ignored and only 
updated when you synchronize before detaching.    

4.2 Operating your computer in Detached Mode 
 
Network/Unplugged is completely automatic and dynamic in the detached mode.  You do 
not have to choose or setup any configurations in this mode.  You turn on the computer in 
the detached mode, and access your network as if you are connected. Make any 
modifications to your network files, create new files, and delete files in the Virtual network 
as if you are connected to the Real network. 
 
The color of the Agent icon indicates what mode you are in. It is blue if you are in the 
Detached Mode and green if you are in the Attached Mode. It is red, if it is in Attached 
Mode but is not able to connect to some of the computers that you have synchronized with. 
 
Note: Be sure to logon as a user onto your Windows desktop, i.e., do not press the cancel 
button on the Windows user logon screen. 
 
If you delete any files from the Virtual Network while you are in the detached mode, those 
files will be deleted from the network when you synchronize.  However, you will be 
prompted before the files are deleted from the network based on the Synchronization 
Preferences you have set. 

4.3 Operating your computer over Remote Access 
 
You can also switch to the Attached Mode by connecting to the remote access server using 
dial-up networking. If you need to connect remotely, take advantage of Network/Unplugged 
features by connecting, synchronizing, disconnecting, and working off-line to avoid the slow 
connect speed and the cost of the connection.  
 
 
 
 

! 
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5 Creating a Virtual Project 
 
Determine which file or groups of files, you will need while detached from the network. 
Enter this information into the system by defining a Network/Unplugged Project.  You can 
define a new Project by following either option described below: 
 
Click on the New Project Wizard button in the Standard toolbar or select (New 
Project Wizard in the File menu option). The wizard guides you through the steps to 
create a Project and it�s associated File Selectors. Follow the steps indicated below to 
setup the Project. 
 
Step1: Enter a name and description for the Project 
Step2: Define Project Properties 
Step 3: Add File Selectors 
Step 4: Synchronize the Project 
 
Step 1: Enter a name and description for the Project  
In this step type a name for the Project and enter a brief description. Then click on the 
next button to go to the next step. 
 

Step 2: Define Project Properties  
In step two of the Project wizard you can set the properties for the Project or leave it to the 
default mode.  
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Step 3: Add File Selectors  
In this step click on the Add file Selector button to select the files and folders on the 
network location that you wish to take offline. Once you have made the selections, the File 
selectors are displayed in the File Selectors window. You can highlight a File Selector and 
click on the File Selector Properties button to see the details. 
 
Step 4: Synchronize the Project  
This is the final step where Network/Unplugged prompts you to synchronize.  By default 
the option is set to �Yes�. You can select� No� and choose to synchronize later. In this case 
Network/Unplugged completes the Project setup without synchronizing the files. But 
unsynchronized files are difficult to maintain, as you have to remember to synchronize later 
to ensure that the Network File versions are in sync with the LOCAL files. So it is highly 
recommended to complete the setup process by synchronizing the files. 
So leave the default option to �Yes� and then click on the Finish button to synchronize and 
finish the Project Setup. The Project and File Selectors are listed in the Project Manager 
window when synchronization is done. 
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6 Backing up with Network/Unplugged 
 
Unlike other Network/Unplugged Projects, Backup Projects are used solely for backing up 
the changes made on the LOCAL machine to the NETWORK Server.   
 
A Backup Project can be created either by using the New Backup Project Wizard icon 
on the toolbar or by selecting New Backup Project Wizard option from the File menu. 
The wizard guides you through the process and the steps include the options for 
synchronization and selecting the destination for the backup files. 
 
There are four simple steps for creating a Backup Project: 
Step 1: Specify Project Name 
Step2: Define Backup Project Properties 
Step 3: Add File Selectors 
Step 4: Synchronize the New Backup Project 
 
Step 1: Specify Project Name 
Launch the Backup Project Wizard and enter a name and description (optional) for the 
Project. 
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Step 2: Define Backup Project Properties 
 
In the �Select destination location� box, type in or use the browse button to select the 
location to which you want to backup your LOCAL files. You can change the other 
properties or leave them as default. 
 

 
 
Step 3: Add File Selector 
Click on the Add File Selector button and choose the files from the LOCAL machine that 
you wish to backup. 
 
Step 4: Synchronize the Backup Project 
When you complete the setup process for the Backup Project, synchronization takes place 
and the files from the LOCAL are backed up to the destination. 
If you are backing up Outlook (.pst) or Access (.mdb) files, after the initial synchronization, 
Network/Unplugged uses iDESP technology for synchronization, thus transferring only the 
changes made to the files on the LOCAL and increasing the speed of backup. 
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7 Backing up Outlook (.pst) Files 
 
Large data files, such as Microsoft Outlook (.pst) files, can be incrementally backed up in 
seconds using Network/Unplugged.  The benefit to the enterprise is that key interactions 
and information stored in mail files is backed up quickly and efficiently, and are always 
protected. Network/Unplugged backups Outlook (.pst) files by employing  �Intelligent 
Delta Selection Processes� iDESP technology where only the changes made to the files, not 
the entire files, are transferred across the network in a compressed format.  This increases 
the speed of synchronization and file backup over slow network connections such as dial-up 
telephone lines, while dramatically reducing network bandwidth consumption. iDESP 
reduces synchronization time by as much as 95-99%. The benefit to the enterprise is reduced 
remote access connection costs, reduced network traffic, and increased user productivity. 
 
To backup Outlook (.pst) files follow the instructions for setting up a Backup Project. 
In step 2, specify the destination where you want the file to be backed up to, and in step 3 
specify the location of your (.pst) files on the LOCAL machine and then complete the setup 
by synchronizing. The first time you backup your file the entire file is backed up to the 
destination location then with subsequent synchronizations only the changes that are made 
to the (.pst) file are logged and backed up. This increases the speed of synchronization and 
you can see a significant difference for large ( .pst) files. 

8 Creating an Any2Any Project 
 
To create an Any2Any Project click on the �New Any2Any Project Wizard� option in the 
File menu or click on the Any2Any Project Wizard icon on the toolbar to launch the Project 
Wizard. 
 
The Any2Any Project Wizard guides you through the following steps to create the Project: 
 
Step 1: Enter a name and description for the Project  
Step 2: Define Project Properties  
Step 3: Add the Source File Selectors and Destination Folders  
Step 4: Synchronize the Any2Any Project 
 
Step 1: Enter a name and description for the Project  
In step one of the Any2Any Project Wizard type a name and description (optional) for the 
Project you wish to create. 
 
Step 2: Define Project Properties  
In this step you can define the Project Properties, specify the synchronization options and 
decide how Network/unplugged should handle conflicts or leave the settings to the default 
mode.  
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Step 3: Add the Source File Selectors and Destination Folders  
In this step the user is provided with the options to add the File Selectors and Destination 
Folders that have to be synchronized. 
 
Click on the Add button next to the File Selector Box and follow the instructions to add the 
File Selector to the current Project.  Once you have made the selection the File Selector that 
you select is listed in the File Selector box. You can use the Add button again if you want to 
add multiple File Selectors to the same Project.  
 
After selecting the Source File Selectors, click on the Add button next to the Destination 
Folder box to select a Destination Folder for your Project, i.e. select the location and the 
folder where you want the Source File Selectors to be synchronized to. Once you select the 
Destination Folder it is added to the Destination Folder box.  You can use the Add button 
again to add Multiple Destination Folders.  You can always use the Delete button, to remove 
a Destination Folder from the list and from the current Project. 
 
Note: The two-way synchronization option requires having only one Source File Selector 
synchronizing to one Destination Folder.  If this option is enabled the files can be 
synchronized from the source to the destination and vice-versa. If you want to have multiple 
Source File Selectors and a single or multiple Destination folders, then only the one-way 
synchronization option should be enabled. In this case the files will always synchronize from 
the source to the destination (one-way only). 
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Step 4: Synchronize the Any2Any Project 
This is the final step in creating the Any2Any Project.  Once the Source File Selectors and 
the Destination Folders are selected, you have completed defining your Any2Any Project. 
You can choose to synchronize this Project right away, or synchronize later. 
If you intend to synchronize now, select �Yes� and click Finish to complete the 
synchronization.  If you select �No�, Network/Unplugged will not perform any 
synchronization now.  Synchronization will be done whenever you synchronize the next 
time. It is recommended to synchronize immediately while creating the Project. 
 
The Project and File Selectors are listed in the Project Manager window when 
synchronization is done. 



Network/Unplugged Client User Guide    

  19  

 
 

9 Deleting Projects 
 
You can delete any Project(s) that you don�t need. The Project Manager allows you to delete 
a Project from the list of Projects, along with all its associated File Selectors.  
To delete a Network/Unplugged Project, just select the Project in the Project Manager 
window and choose from any of the following options: 
 
a) Select the Delete Projects Option from the Edit menu 
b) Press the Delete Key on the Keyboard. 
c) Right-click on the Project name and in the resulting shortcut menu select Delete 

Projects� 
Once you have made the selection, Network/Unplugged will prompt to confirm the 
deletion. Click yes to delete and no to abort. If you click yes the selected Project and its 
associated File Selectors will be deleted. 
 
To select multiple Projects and its associated File Selectors for deletion, click on a Project 
then use the Ctrl key and click on the other Projects to make the selection. 
 
Note: When you delete a Virtual Network Project and its associated File Selectors, files 
and folders that are in the cache i.e. the files that have been synchronized to the LOCAL 
machine will be deleted from the LOCAL machine only, provided they do not belong to 
some other Project that is not being deleted. 
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10 Deleting File Selectors 
 
You can delete any File Selector that you don�t need. In the Project Manager window when 
you select a Project in the left pane you will see the associated File Selectors in the right 
pane. Select the File Selector that you want to delete and then choose any of the following 
options to delete the File Selector: 
 
a) Select the Delete File Selectors Option from the Edit menu. 
b) Press the Delete Key on the Keyboard. 
c) Right-click on File Selector and in the resulting shortcut menu and select Delete File 

Selectors. 
d) Once you have made the selection, Network/Unplugged will prompt to confirm the 

deletion. Click yes to delete and no to abort. . 
 
 
Deleting File Selectors of Virtual Projects 
If you have a Virtual Project set up and you delete the File Selectors for this Project, you are 
prompted to choose from the following options: 
 

Option 1: Delete the File Selector information and the associated LOCAL files 
by synchronizing 
If this option is selected and you click the OK button, Network/Unplugged starts the 
synchronization process and proceeds to delete the Files and Folders that are in the 
local cache i.e. the Files and Folders on the LOCAL machine only. After 
synchronization the File Selector is deleted from the listing in the Project Manager 
window. 

 
Option 2: Delete the File Selector information only 
If this option is selected and you click the OK button, Network/Unplugged removes 
only the File Selector listing from the Project Manager window and the Files and 
Folders in the LOCAL cache are not removed. 
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11 Synchronizing with Network/Unplugged 
 
Network/Unplugged synchronization ensures your access to up-to-date information. 
Synchronization keeps the file versions between the two locations that you have chosen 
to synchronize to, or synchronize from, identical, so that the changes you make to the 
files are reflected in the files in both the locations and you are always working with the 
latest version of the file 
 
Network/Unplugged implements a simple rule to ensure effective synchronization: 

 
Synchronize Initially 
 
To use Network/Unplugged initially 

a) Define one or more Network/Unplugged Projects 
b) Synchronize 

 
Synchronize Regularly 
 
On an ongoing basis 

a) Before you detach���..Synchronize 
b) Immediately after you attach�. Synchronize 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The software 
identifies files that 
will be affected by 
synchronization, 
and asks for 
permission before 
making changes 
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12 Conflict Management and Resolution 
12.1 What is a Conflict?  
 
If a file has been updated by a user in the detached mode, and the same file has been 
updated or removed from the NETWORK Server by another user at the same time, during 
synchronization a conflict occurs, as the files in both the LOCAL and the NETWORK are 
not identical i.e. they both have different modifications. It is advisable to resolve conflicts 
immediately for effective file management.  Otherwise the file versions on the LOCAL 
machine and the NEWORK Server will continue to differ and user will not be working 
productively with up-to-date information. 

12.2 Identifying and Resolving File Conflicts 
 
When the synchronization process is initiated, Network/Unplugged performs an analysis 
and alerts you if conflicts exist, before proceeding with synchronization. A Synchronization 
Preview window appears listing the files and folders that have the conflict.  If you wish to 
resolve the conflict immediately you can right click on the file that has a conflict and select 
Resolve Conflicts. Network/Unplugged presents you with a set of options to choose from 
to resolve the conflict.  Once you make a selection click update to resolve the conflict. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

If a conflict is identified, 
double-click or right-click 
on the file indicated and 
follow instructions on the 
screen 
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This process has to be repeated for each and every file that has been listed with a conflict.  
On resolving the conflicts you can proceed with synchronization and Network/Unplugged 
updates the files based on the resolution that you have chosen. 
 
If you do not want to resolve the conflict immediately you can go ahead and proceed with 
synchronization.  In this case no action will be taken for the conflicted files and all the other 
files will be synchronized.  On completion of synchronization Network/Unplugged retains 
the list of files that have the conflict in the Conflict Resolver window.   

12.3  Using the Conflict Resolver 
 
If you do not resolve the conflicts at the time of synchronization the conflicts remain open 
in the Project Manager in a separate window called the Conflict Resolver, as a constant 
reminder to the user to resolve the conflicts before the next synchronization. It is advisable 
to resolve conflicts immediately for effective file management.  Otherwise the file versions 
on the LOCAL machine and the NETWORK Server will continue to differ and user will not 
be working productively with up-to-date information. 
 
To resolve conflicts in the Conflict Resolver click on the Resolve Conflict option in 
the Synchronization menu. (Or click on the Resolve Conflict icon on the toolbar).  
A list of files in conflict and the options to solve the conflict will appear. Make your 
selection and click on the update button. Repeat this step for each file listed in the Conflict 
Resolver. The next time you synchronize the conflict will be resolved.  
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13 Using Network/Unplugged Agent 
 
The Network/Unplugged Agent is a handy tool that gives you quick access to the 
Network/Unplugged application and to the status of network resources that you have 
synchronized to. 
 

13.1 Accessing the Agent 
 
The Network/Unplugged Agent can be accessed by clicking the right-mouse button on 
the Agent icon displayed on the Windows taskbar or by clicking on the Start button, going 
to Programs, Network/Unplugged Program and selecting the Network/Unplugged 
Agent option in the resulting menu. 
 

13.2 Using the Icon as a Status Indicator 
 
The color of the Network/Unplugged Agent icon in the Windows taskbar gives a quick 
graphical view of the computers that you use in the detached mode. The Agent only 
evaluates the status of the computers that you have synchronized to in the past. 
 
Status options:  
 

• If none of the network resources are physically reachable, the color of the icon is 
blue. 

• If the REAL network is physically reachable, the icon is green. 
• If some of the computer resources are available the icon is red. This happens when 

some of the servers are down. 
 
 
 
 

 
 
 
 
 
 
 
 
  

Icon changes color 
based on available 
network resources. 
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13.3 Using Network/Unplugged Agent Features 
 
You can access the Network/Unplugged Agent features clicking the right-mouse button 
on the Agent icon on the windows taskbar. 
 
It provides the following options: 
 

Synchronize Performs the "Synchronize" operation of Network/Unplugged.  
Run 
Network/Unplugged 

Executes Network/Unplugged application 

Display Network 
Resources 

Displays the status of computers that are available to your mobile 
computer.  

Scheduler Launches Network/Unplugged Scheduler to create scheduled 
synchronization tasks. 

View Logs Use this option to view the log files created by Network/Unplugged 
during synchronization. 

Go to Home Page Links to Mobiliti Web page http://www.mobiliti.com 
Shutdown Sync 
Options 

If you want to synchronize immediately and execute either a Log Off, 
Shutdown or Restart of the computer you can make the appropriate 
selection from the commands listed under this option. 

Close Closes Network/Unplugged Agent and removes the Agent Icon from the 
taskbar. 

Synchronize and 
Force Complete 
Virtual Network  

Users can choose this option to synchronize the files and then switch 
completely to the Virtual Network even though they are physically 
connected to the Real network.  
Note: The �Synchronize and Force Complete Virtual Network� option is 
only enabled in the Agent when the Polling Preference is set to either �Off. 
Do not perform any polling� or �Actively sense and ask me before 
switching� 

Force Complete Real 
Network and 
Synchronize 

This option allows the users to switch from the Virtual Network to the 
Real Network and to synchronize immediately on switching to the Real 
Network.  
Note: The �Force Complete Real Network and Synchronize� option is 
enabled in the Agent only if the Polling Preference has been set to  
�Actively sense and ask me before switching� and the user has forced 
complete Virtual Network through the Agent option.  

Force Complete 
Virtual Network and 
Force Complete Real 
Network 

These options are enabled in the same way as the options �Synchronize 
and Force Complete Virtual Network� and �Synchronize and Force 
Complete Real Network�.  
The only difference is that synchronization does not take place 
automatically when there is a change from the Real to Virtual Network 
and vice-versa. 

 
 
 

http://www.mobiliti.com/
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14 End User License Agreement 
 
Important * Read Carefully * End-User License Agreement for Mobiliti, Inc.  The 
End-User License Agreement (EULA) is a legal agreement between you (the individual user 
or company) and Mobiliti, Inc. for the Network/Unplugged� Client software 
(SOFTWARE PRODUCT).  
 
SOFTWARE PRODUCT LICENSE:  U.S. Copyright laws as well as other intellectual 
property laws protect the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is 
licensed to you on a non-exclusive basis under the terms of this EULA, but not sold. 
 
GRANT OF LICENSE:   This EULA grants you the following rights only: 
You may use one copy of the SOFTWARE PRODUCT on a single computer solely for 
internal business purposes. The SOFTWARE PRODUCT is in "use" on a computer when it 
is loaded into temporary memory (i.e., RAM) or installed into permanent memory (e.g., hard 
disk, CD-ROM, or other storage device) of that computer.  You may not install the 
SOFTWARE PRODUCT on a network server and such type of installation is prohibited 
under this EULA and is grounds for termination.  You may make one copy of the 
SOFTWARE PRODUCT solely for backup or archival purposes. 
Solely with respect to electronic documents included with the SOFTWARE PRODUCT, 
you may make an unlimited number of copies (either in hardcopy or electronic form), 
provided that such copies shall be used only for internal purposes and are not republished or 
distributed to any third party and that all copies contain the applicable copyright notices. 
 
COPYRIGHT, TRADEMARKS, AND OTHER PROPRIETARY RIGHTS:  All 
rights and title in the copyrights, trademarks, patent rights and any other intellectual property 
rights in and to the SOFTWARE PRODUCT (including but not limited to any images, 
photographs, animations, video, audio, music, and text, incorporated into the SOFTWARE 
PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE 
PRODUCT are owned by Mobiliti, Inc. and nothing in this EULA will be construed as 
granting any of these rights to you.  All rights not expressly granted under this EULA are 
retained by Mobiliti, Inc.  The copyright notices and other proprietary legends shall not be 
removed from the SOFTWARE PRODUCT and documents and no use of trademarks is 
granted under this EULA. 
 
DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS:  Limitations on 
Reverse Engineering, Decompilation, and Disassembly: You may not reverse engineer, 
decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that 
such activity is expressly permitted by applicable law notwithstanding this limitation.  No 
Separation of Components. The SOFTWARE PRODUCT is licensed as a single product 
and neither the software programs making up the SOFTWARE PRODUCT or any  new 
version  (UPGRADE) may be separated for use by more than one user at a time. If the 
SOFTWARE PRODUCT is an UPGRADE you may use or transfer (in accordance with the 
Software Transfer provision, below) the UPGRADE only. 
 
RENTAL:  You may not rent or lease the SOFTWARE PRODUCT.  
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SOFTWARE TRANSFER:  You may permanently transfer all of your rights under this 
EULA to another single user, provided that you retain no copies, you transfer all of the 
SOFTWARE PRODUCT (including all component parts, the media and printed materials, 
any UPGRADES, this EULA, and, if applicable, the Certificate of Authenticity), and the 
recipient agrees to the terms of this EULA. If the SOFTWARE PRODUCT is an 
UPGRADE, any transfer must include all prior versions of the SOFTWARE PRODUCT.  
You will send written certification to Mobiliti, Inc., within three (3) days of such transfer, 
verifying the transfer of all SOFTWARE PRODUCT.  Failure to provide notice shall result 
in the termination of this Agreement and any transfer shall be null and void. 
 
TERMINATION:  Without prejudice to any other rights and without any liability on the 
part of Mobiliti, Inc., Mobiliti, Inc. may terminate this EULA if you fail to comply with the 
terms and conditions of this EULA. In such event, you must immediately destroy all copies 
of the SOFTWARE PRODUCT and send Mobiliti, Inc. written certification of such 
destruction within three (3) days.   
 
LIMITED WARRANTY:  MOBILITI, INC. WARRANTS TO THE ORIGINAL 
PURCHASER ONLY, THE SOFTWARE PRODUCT SHALL MATERIALLY 
CONFORM TO THE SPECIFICATIONS IN THE WRITTEN DOCUMENTATION 
UNDER NORMAL USE FOR A PERIOD OF NINETY DAYS FROM THE DATE OF 
LICENSE. IF THE SOFTWARE PRODUCT WAS ELECTRONICALLY 
TRANSMITTED, THE FOREGOING WARRANTY WILL APPLY TO THE 
SOFTWARE PRODUCT AT THE TIME OF TRANSMISSION FROM MOBILITI, 
INC.  IF DURING THIS NINETY-DAY PERIOD THE SOFTWARE PRODUCT 
DOES NOT MATERIALLY CONFORM TO THE DOCUMENTATION, MOBILITI, 
INC. WILL EITHER, AS APPLICABLE AND WITHOUT CHARGE (i) RESEND THE 
SOFTWARE PROGRAM, PROVIDED, THE DEFECTIVE SOFTWARE PROGRAM 
HAS BEEN RETURNED, OR (ii) RETRANSMIT ELECTRONICALLY THE 
SOFTWARE PRODUCT.  THE FOREGOING IS CONTINGENT ON YOU HAVING 
PREVIOUSLY SENT IN OUR LIMITED WARRANTY REGISTRATION CARD TO 
MOBILITI, INC. OR SENT PROOF OF PURCHASE OF THE SOFTWARE 
PROGRAM. 
 
YOUR SOLE AND EXCLUSIVE REMEDY IN THE EVENT OF A DEFECT IS 
EXPRESSLY LIMITED TO REPLACEMENT OR RETRANSMISSION OF THE 
SOFTWARE PROGRAM AS PROVIDED ABOVE. IF FAILURE OF THE 
SOFTWARE PROGRAM HAS RESULTED FROM ACCIDENT OR ABUSE, 
MOBILITI, INC. SHALL HAVE NO RESPONSIBILITY TO REPLACE OR 
RETRANSMIT THE SOFTWARE PROGRAM UNDER THE TERMS OF THIS 
LIMITED WARRANTY. 
 
EXCEPT AS PROVIDED ABOVE, THIS SOFTWARE PROGRAM, AND ANY 
DOCUMENTATION, INCLUDING BUT NOT LIMITED TO, THE INSTRUCTION 
MANUAL, AND REFERENCE MATERIALS ARE LICENSED AS IS, WITHOUT 
WARRANTY, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR 
PURPOSE, TITLE OR NON-INFRINGEMENT.  THE ENTIRE RISK AS TO THE 
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RESULTS, USE OF THE RESULTS AND PERFORMANCE OF THIS SOFTWARE 
PRODUCT IS ASSUMED BY Y0U. 
 
MOBILITI, INC. SHALL NOT BE LIABLE TO YOU OR ANY THIRD PARTY FOR 
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES 
WHETHER ARISING UNDER CONTRACT, WARRANTY OR TORT (INCLUDING 
NEGLIGENCE OR STRICT LIABILITY) OR ANY OTHER THEORY OF 
LIABILITY.  MOBILITI, INC.�S AGGREGATE LIABILITY FOR DAMAGES, 
REGARDLESS OF THE FORM OF THE ACTION, SHALL NOT EXCEED THE 
AMOUNT PAID BY YOU TO MOBILITI, INC. FOR THE SOFTWARE PRODUCT.  
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS 
MIGHT NOT APPLY TO YOU.  The limitations of liability reflects the allocation of risk 
between the parties.  The limitations specified above will survive and apply even if any 
limited remedy specified if the EULA is found to have failed of its essential purpose. 
 
U.S. GOVERNMENT RESTRICTED RIGHTS:  Use, duplication or disclosure by the 
U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights 
in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs 
(c)(1) and (2) of the Commercial Computer Software-Restricted Rights clause at 48 CFR 
52.227-19, as applicable. 
This EULA merges all prior written and oral comments and defines the entire agreement of 
the parties concerning the SOFTWARE PRODUCT.  In the event any portion of this 
EULA shall be held illegal, void or ineffective, the remaining portions hereof shall be valid 
and enforceable.  This EULA shall be construed in accordance with the laws of New Jersey 
without regard to its conflicts of laws provisions.  Both parties submit to the jurisdiction of 
the federal and state courts of New Jersey.  You agree and acknowledge that any breach of 
this EULA will cause Mobiliti, Inc. irreparable harm and Mobiliti, Inc. may obtain injunctive 
relief as well as seek all other remedies available to Mobiliti, Inc. in law and in equity. The 
U.N. Convention for the Sale of Goods shall neither govern nor be applicable to this EULA.  
You acknowledge that you will comply with the laws and export regulations of the United 
States. 
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